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Welcome to PIA  

Welcome to PIA Property Investment Analysis, a powerful program designed 
to make it easy for investors to analyse and evaluate prospective property 
investments.  

PIA helps you analyse the capital growth, cash flows and rates of return on 
investment properties, taking tax implications into account. It is simple to use 
and – as a decision tool – provides the answers to a long list of "What ifs" on 
property investment. PIA is an analysis tool – it is not an accounting tool.  

On the market since 1989, PIA has become an industry standard in Australia 
and New Zealand, used extensively by leading real-estate groups, property 
marketers, banks, lenders and accountants, and by thousands of property 
investors.  

PIA was developed to complement the bestselling books on property 
investment by Jan Somers. The latest books in this series are:  

 Building Wealth Story by Story 

 More Wealth from Residential Property 

This PIA Quick-Start Guide is based on PIA Version 8.1, edition 00.  

What PIA can do for you 

Briefly, PIA can help you make objective decisions about a potential property 
investment. You can quickly estimate your rate of return, tax savings, true 
after-tax cost, and affordability. Furthermore, you can very easily test the 
sensitivity of your results (i.e. playing “What if”) by making changes to the 
variables like growth, inflation and interest rates. Finally you can print out a 
professionally structured report to help you present your investment proposal 
to your accountant or bank manager.  

Two different versions 

PIA is a standalone Windows program (Vista, Win 7, 8, 10) available in two 
different versions to suit property investors and industry professionals:  

PIA Investor – PIAFpu (Fpu = for personal use) – is suited to investors as it 

has a single-user license and is for personal use only.  

PIA Professional – PIAPro (Pro = professional) – is better suited to industry 

professionals who want to use PIA in a consulting capacity to show investors 
the benefits and implications of property investment. It has all the features of 
the PIA Investor as well as a site license and additional client-related 
features such as client fields and professional disclaimers in reports. 

About this book 

This Quick-Start Guide is designed to help first-time users get started with 
PIA. It assumes that you are acquainted with the basic concepts of your 
computer and the Windows user interface.  
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To ensure a smooth start, the book guides you through installing your 
software, starting it, and entering your first set of data. You can either enter 
the data shown in the example in this guide (treating the whole description as 
a tutorial) or enter your own data.  

By the end of the book you will be able to use the spreadsheet to answer 
simple questions like:  

• What return can I anticipate on my investment? 
• What will it cost me after tax?  
• How much tax will I save? 

But there is a lot more to PIA than can be covered in this Quick-Start Guide. 
Details are given towards the back of this guide on where to find out more 
information to help you become even more adept with the program.  

If you get stuck  

First, please read this Quick-Start Guide. It guides you through the basic 
steps of an investment analysis. 

Secondly, use the online help. You can access this from anywhere in the 
main part of the program by pressing F1 or by accessing Help via the Help 
menu.  

Tool tips are available for the icons in the toolbar of the spreadsheet and for 
the buttons in the Data Entry Check List. These appear if you position the 
mouse pointer over the icon or button. You can get context-sensitive help by 
clicking on the "?" button in most dialogs.  

If all else fails, you can obtain technical support by sending an email to 
support@somersoft.com.au. A good option is to use the Support On-Line 

feature under the Help menu which generates an email to technical support 
with a copy of your file as an attachment.  

User feedback   

We welcome feedback from users – it helps us to give you what you want. 
So please do not hesitate to make comments or suggestions. You can use 
the Feedback email function under the Help menu or feedback form in the 
Support section of the website (www.somersoft.com.au) to submit your 
comments.  

mailto:support@somersoft.com.au
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Installing the software 

What you need  

To run PIA Version 8.1 you will need a personal computer with at least 12 
MB of free disk space and Windows Vista, Win 7, 8 or 10.  

Installation is via a download from our website, is very simple and takes just 
a few minutes. Please follow the steps described below.  

1. Open your web browser and enter www.somersoft.com.au/pia.htm in 
the address bar.  Click to download PIAPro or PIAFpu depending on 
the program you have chosen. If you are asked by the browser 
whether to open/run the file or save it to disk, choose open/run (this 
will automatically run the install once it has downloaded). If you save it 
to your downloads, you will need to locate and run the downloaded 
file.  

2. When the installation routine runs on your PC, it will first confirm the 
Publisher is Somerset Financial Services Pty Ltd and then the version 
and edition being installed..  

3. Read the Setup Welcome dialog. It is recommended that you close all 
Windows applications before continuing. Click on Next > to continue.  

4. Read the Readme File information for the latest news on PIA, then 
click Next > to continue with the installation. 

5. In the Destination Location dialog, click Next > to confirm the default 
location. You may select a different location using the Browse button, 

but this is not recommended as it may cause later problems with 
upgrading and support.  

6. The Start Installation dialog appears. Check the details and click Next 
to start the installation, or click on Back to go back to make changes.  

7. The Setup Complete dialog appears. Click Finish to complete setup.  

Installation is now complete and PIA opens. Normally you will start PIA by 
clicking on the desktop icon or by using the Windows Start menu and 
selecting Programs then PIA.  

 In this Guide, the name PIA is used to refer to the two versions of PIA 
(PIAFpu or PIAPro) as described on page 1. 

 Note that PIA will only run in demonstration mode until you complete the next 
step to enter your licensee name and registration code. This can be entered 
at the time you start the program or via the Register item under the Help 
menu within PIA  

file:///C:/Users/Ian/Documents/Work/PIA/PIA75/Documentation/www.somersoft.com.au/pia.htm
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Using PIA  

Starting PIA the first time ever 

The first time you ever use PIA on a particular computer, you will be 
prompted to enter your specific licensee name and corresponding 
registration code (see your tax invoice or email notification). If you enter the 
correct name and code, the confirmation message "Welcome to the World of 
Property Investment" is displayed.  

 

Fig. 1: The Congratulations screen   

Congratulations! You have then successfully installed the software. 

 If the number you enter is incorrect, the program will run in demonstration 
mode only. To access the full version of the software, you will need to re-
enter the licensee name and registration number either by re-running the 
software or by accessing the Register item under the Help Menu. 

You will then be asked to specify your location (Australia or New Zealand) – 
this sets the default tax scales for the calculation of tax credits. Click OK.  

If you have chosen Australia, you will then be asked to specify which State 
(QLD, NSW, VIC etc.) for the correct stamp duty and sales commission 
scales. Select the state in which your property is located. (You can, of 
course, change the scales used at any time.) Click OK.  

PIA saves all of these changes and will continue to use them until you 
change them again. PIA will then open with the Welcome screen.  

Starting PIA 

Normally, to start PIA you need only double-click on the PIA icon on the 
desktop and the Welcome screen appears immediately (see Fig. 2). This is 
the screen you will see whenever you start PIA. It gives version, license and 
copyright details and allows you to select which file you want to open.  

 Your icon will show the version of the PIA software you have installed. 
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When the PIA Welcome screen appears, you have the choice of opening the 
latest property file you saved, opening any previously saved file, or creating a 
new property file. If you are using PIA for the first time, select the Create a 
new property file radio button and click on OK.  

 

Fig. 2: PIA Welcome screen   

 Note that the Version number in the Welcome screen is given as four digits 
(e.g. 7.550). The first two digits (7.5) represent the actual version number 
while the last two (50) represent the edition number. Updated editions will  
be released on our web site from time to time as new features are added, tax 
laws and State taxes change, and when changes are needed to improve the 
program. These updates are available free of charge to registered users for 
at least two years from the date of purchase of their original software 

www.somersoft.com.au 
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Before we start  

Plug 'n' Play 'n' Print 

The next section takes you step by step through entries to complete your first 
property investment analysis. You can then look at the results and make 
changes in the spreadsheet and, once you are satisfied, print out a report.  

 

Fig. 3: The PIA Plug 'n' Play 'n' Print procedure 

 When you are more experienced with PIA, you may choose to enter data 
straight into the spreadsheet and skip the Data Entry Check List altogether. 

Plug 

in the data with the 
 Data Entry Check List.  

This is the most intuitive way 
for new users to enter data.  

 

 

Play 
with the parameters on the 

spreadsheet. 

This is where experienced 
users spend most of their time. 

Enter changes and see the 
impact on the fly!  

 
 

Print 
your results in the form of  

a report.  

This is a great way to convince 
lenders that you have done 

your homework.  
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PIA overview 

In fact, PIA has four separate spreadsheets, a multitude of dialogs, and a 
whole suite of property-related calculators that, together, fulfil a wide variety 
of investment and financial functions.  

While it may have spreadsheet-like screens, PIA is a stand-alone program, 
written in a language called C++. However, in many ways it behaves like 
other spreadsheet programs:  

 If you make a change to one variable, the change is automatically 
reflected throughout.  

 PIA stores data on each of your investment properties in separate 
files. To analyse the cash flows on your entire portfolio of investment 
properties (Portfolio Analysis), you simply specify which files you 
wish to include and PIA does all the synchronisation and collation for 
you. 

 A new file always opens with a template of default values. These 
values can then be tailored to the property being reviewed and the 
new set of variables can even be saved as the new default template. 
If you are using PIA for your own use only, it is recommended that 
once you modify personal variables (e.g. home loan status, living 
expenses, etc), you should save them as part of the default template 
(Settings menu). 

The screens that you will spend most of your time interacting with PIA are 
the Data Entry Check List and the four spreadsheets (Investment Analysis, 
Home Loan Analysis, Wealth Builder & Linked Loans). While this booklet 
focuses mainly on the Data Entry Check List and the Investment Analysis 
Spreadsheet, the roles of each of the screens are described below: 

The Data Entry Check List 
provides an intuitive 
interface for entering data 
about an investment 
property, how it is to be 
financed, how tax credits are 
to be calculated, and how 
these variables are to 
change over time. This 
would normally be the first 
step in analysing any 
prospective property as it 
helps construct an 
Investment Analysis 

spreadsheet with all of the  
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appropriate starting values. 
 

The Investment Analysis Spreadsheet is the main 
focus of PIA and of this Quick-Start Guide. You will 
find that you spend most of your time within this 
spreadsheet as it gives you instant answers on 
how much a prospective investment property is 
likely to cost you after tax and what rate of return 
you might anticipate for the data you have entered. 

 

The Home Loan Analysis Spreadsheet is used to 
describe the status of your home loan (i.e. how 
much is still owing and what your repayments are). 
You can use it to analyse ways of repaying your 
home loan faster (e.g. by way of additional 
payments, fortnightly payments or a credit line) or 
even to consolidate and refinance several non-
deductible loans into one.  

 

The Wealth Builder Spreadsheet helps you 
interactively plan a portfolio of investment 
properties based on projected multiples of the 
property under review in the Investment Analysis 
Spreadsheet. At each step (that is, each year) you 
can see whether you would have the necessary 
funds (cash savings) and whether the banks would 
be likely to lend you the finance (loan/value ratio 
and debt /service ratio). This spreadsheet 
integrates data from the investment property under 
review, your home and any existing investment 
property portfolio. 

 

The Linked Loans Spreadsheet allows you to 
explore methods of repaying non-deductible loans 
faster using surplus cash flows from an investment 
property. Where a credit line is the preferred 
method for repaying a home loan, the Linked 
Loans Spreadsheet also allows you to take 
account of the after-tax cost of an investment 
property, though this can also be explored in the 
Wealth Builder. 
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Getting started 

This section guides you through the entries you need to make in order to 
complete your first property investment analysis. You can either use the data 
given in the example or your own data. If you use the example data shown 
here, the dialogs and screens you see should be identical to those shown in 
this guide, allowing you to confirm your progress. This section takes about 40 
minutes to complete.  

We strongly recommend that you first work through the steps with the data 
shown here in our fictitious example and then repeat the procedure using 
your own data.  

Step by step to your first analysis 

This section takes you through the Data Entry Check List to build your 
spreadsheets. Each item in the Check List is required for the initial analysis. 
When you have made all the entries, you can click Spreadsheet to go to the 
main Investment Analysis Spreadsheet. Once in the spreadsheet, you can 
return to the Data Entry Check List at any time by choosing the Data Entry 
Check List item under the View menu. 

Our example  

John earns $85,000 per year as a journalist. His wife Anthea earns $45,000 
per year working part time. They have a family home worth about $580,000 
on which they still have $120,000 outstanding. They have just read the book 
More Wealth from Residential Property by Jan Somers and while it made a 
lot of sense, it all sounded too good to be true. To help them better 
understand how negative gearing works, they decide to evaluate a typical 
investment property for themselves using the PIA software. They see a 
property advertised for sale for $480,000 and their research has shown $395 
per week to be a reasonable rent. They want to use PIA to find the answers 
to the following questions: 

• What return on investment can they anticipate? 
• What will the investment cost them after tax? 
• How much tax will they save? 
• Can they afford it? 
• Can they afford more investment properties? 
• Will the bank lend them the money? 

They decide to use the equity in their own home as collateral and borrow 
enough to cover all costs, including purchase and loan costs. The prevailing 
interest rates are around 4.8% and they are most comfortable with the idea 
of a principal & interest loan to be repaid over 30 years. Because they both 
work, they want to use an agent to manage the property on their behalf.  

Other key data, most of which they will estimate based on the experience 
with their own property, is introduced during the example.  
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Data Entry Check List  

When you select Create a new property file in the Welcome screen and click 
OK, the Data Entry Check List is displayed. This dialog is a quick, easy and 

intuitive way for new users to enter all the basic data for a new property file. 

 

Fig. 4: Data Entry Check List (showing the Property page with its original 
default values) 

As you can see, the Data Entry Check List is divided into four pages of 
variables covering the key components of a property analysis: 

 Property 

 Finance 

 Investor 

 What If? 

Each page is accessed by clicking on the corresponding tab at the top of the 
dialog. The variables in the first two pages relate to the investment property 
(Property tab) and how it is to be financed (Finance tab). The Investor 
variables record personal details needed to determine specific tax benefits, 
as well as the investor's borrowing and investment capacities. The "What If?" 
variables allow you to see what might happen over time with different 
inflation and growth rates. Already you can see some of the power of PIA – it 
allows you to play with the variables and see what happens. 
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If you move the mouse pointer over the item names in the central column (for 
example, Property Value), the item changes colour and the mouse pointer 
changes to a hand. This indicates that the item is a button that, if clicked on, 
opens a dialog to view and edit the variables that make up or determine the 
item’s value. In fact, the dialog opens if you click on either the variable name 
(button) or its current value, which is shown on the right. 

To help keep track during data entry, a red tick () is shown on the right 
when you have viewed the corresponding dialog and clicked OK to exit, 

whether or not you have made changes in that dialog. 

Many of the items in the Data Entry Check List are actually made up of, or 
are the function of, a number of other variables. In fact, PIA uses over 100 
variables in analysing a property investment. Instead of having to enter all of 
them each time, PIA uses default values when the file is created. 

 The Data Entry Check List is a useful but not a critical step in analysing a 
property investment. As you will see later, all of the variables in the Check 
List can be entered directly from the main spreadsheet. This has the 
advantage of showing instant feedback, but is less intuitive and does not 
show which variables have yet to be changed. However, once you become 
familiar with the program and all of the variables, you may well choose to 
bypass the Check List altogether. (See the Display tab in the Preferences 
item of the Settings menu.)   
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Plug: Using the Data Entry Check List  

In this example we will run through all the items page by page and from top 
to bottom, entering data for each one. When we have done that, we will then 
go to the main spreadsheet of the program to see the results. 

 

 

 

 

 

 

Fig. 5: Options from the Check List  

Clicking on the “?” button displays help for the current screen.  

 You can make your current values in the Check List the default values by 
checking the "Use these values as the new defaults" check box. New files 
then open with these values set. The values will only be adopted if you click 
Spreadsheet to exit the Check List.  

Clicking on Spreadsheet takes you to the spreadsheet – we will be doing 

that when we have entered all four pages of data for our example. 

Sets current values as 
defaults for new files. 

Takes you to the 
spreadsheet. 

Accesses 
Help. 
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Property Details 

The first of our four Data Entry Check List pages is the Property page (Fig. 4) 
and the first item on this page is Property Details. 

Click on Property Details. The Property Details dialog opens. This allows you 

to load an image (jpeg format) of the property as well as enter its address 
and a brief description. These items are saved in the file you are creating, 
and appear in the relevant fields in any reports you generate. You could also 
record extensive notes about the property in the Notes area. These would 
also be saved in the file, but would not appear in any report. 

 

Fig. 6: Property Details dialog  

In our example, we will simply enter the address (74 Layburn Rd, Cleveland, 
Qld, 4163) and a brief description (3-bedroom lowset brick on large block) as 
shown above, then click OK.  

The address and brief description will now appear below the property image 
on the Data Entry Check List and a red tick is displayed to the right of the 
Property Details button to indicate that these particular variables have now 
been checked. 

 As you will see in the next step, for convenience, some variables can be 
entered in more than one dialog and can later be changed in the 
spreadsheet that we create. 
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Property Value 

Click on Property Value. The Property Value dialog opens. Note that the 
address and description are displayed. The house in our example costs 
$480,000. Overwrite the default entry of $500,000 with $480,000 and press 
the Enter key. 

 

Fig. 7: Property Value dialog  

As you can see, the increase in market value of the property has been 
automatically calculated based on a default increase in value of 4.0% per 
year. (Later, you will learn how to change this default value.) Pressing the 
Enter key (sometimes called the Return key) before clicking OK allows us to 

make changes to several variables and see their immediate impact before 
returning to the Check List. 

Click OK to return to the Data Entry Check List. The value $480,000 appears 

in the Check List, and a red tick again appears on the right to indicate that an 
entry has been made. 

 As you can see, the Property Value dialog allows you to enter other values, 
such as renovations, furniture packages, and the address and description of 
the property. Also, you can see at the bottom right of the screen that various 
values can be linked to the property price. This means that the default values 
for these variables are automatically determined by the property price. If the 
price is changed, then the variable is also changed.  
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Purchase Costs  

Click on Purchase Costs in the Check List to display the Purchase Costs 
dialog. The Purchase Costs dialog shows the property price of $480,000 you 
entered a moment ago. Purchase costs include conveyancing costs, stamp 
duty, transfer of title and may also include other costs such as interstate 
travel to select the property.  

Conveyancing costs vary considerably and it may be worthwhile shopping 
around. In our example, the solicitor has quoted $1,250. Overwrite the 
default value of $2,500 with $1,250 and press the Enter key. 

  

Fig. 8: Purchase Costs dialog  

As we saw in the previous dialog, stamp duty was linked to the property price 
and is hence calculated automatically according to the State entered on 
initial start up – but this can be changed at any time. If you selected Qld, for 
example, "Uses Qld" is shown under Stamp Duty Scales. If not, you will have 
to change it for the tutorial – no problem. Click on Reset Scales. The Stamp 
Duty Scales dialog appears. Click on the Qld radio button to set the 
Queensland scale. Click on OK. Uses Qld now appears under Stamp Duty 

Scales in the Purchase Costs dialog.  

PIA calculates the stamp duty and transfer of title fees based on the 
purchase price and the specified State. The values now shown are $15,225 
(stamp duty) and $1,201 (transfer of title). Click OK to save the values and 

return to the Check List. The Purchase Costs are now shown as $17,676. 
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Rental Income 

Click on Rental Income in the Check List to display the Rental Income dialog. 
This dialog is divided into sections, one of which relates to holiday letting 
only. The property we are analysing is to be permanently let with an 
anticipated rent of $395 per week. Overwrite the default value with $385 and 
press the Enter key. The values for Potential annual rent and Actual annual 
rent change accordingly. The difference between the Potential annual rent 
and the Actual annual rent is determined by the Annual vacancy rate. The 

default of 2% may be a realistic value for this suburb at this time, but John 
wants to play it safe and is basing his calculation on 3%. Change the default 
value of 2% to 3% and press the Enter key. PIA calculates the Actual annual 
rent and displays the new value: $19,924. 

 

Fig. 9: Rental Income dialog  

The Rental Income dialog offers other options, including a subdialog for 
specifying how the projected annual rents are to be determined. We will skip 
this for the moment. Click OK to return to the Data Entry Check List. The 

Rental Income is shown as $19,924. 
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Rental Expenses 

Click on Rental Expenses in the Data Entry Check List to display the Rental 
Expenses dialog. This dialog allows you to enter the expenses associated 
with the property. Agent's Commission is the management fee paid to the 
agent. Here the agent has quoted 8.25%. Click on the Agent's Commission 
button and enter 8.25% in the Agents Commission dialog. Click OK to return 

to the Rental Expenses dialog. (Alternatively, you can enter an annual 
amount directly in the Agent's Commission field in the Rental Expenses 
dialog.)  You can move from field to field with Tab or the arrow keys. You can 
update the dialog by pressing the Enter key after each entry. 

Enter the following values: 
Letting fee $395 Maintenance $800 
Council rates  $1,600 Pest control $120 
Insurance $800 Other expenses $250 

The Rental Expenses dialog should now look like this: 

 

Fig. 10: Rental Expenses dialog  

There are many other options in the dialog, but we will skip them for the 
moment, clicking OK to return to the Data Entry Check List, which now 

shows Rental Expenses of $5,609.  
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Depreciation of Building 

Click on Depreciation of Building in the Check List to display the Depreciation 
of Building dialog. As you can see, our property price of $480,000 has been 
adopted here. The default Building Cost is calculated at 50% of the value of 
the property (here: $240,000). Our building has an estimated original 
construction cost of $220,000, so enter this figure in the Building costs box 
and press Enter. Note that the Building costs as a % of property price is 
recalculated (45.83%), as is the Depreciation of building ($5,500). The 

default depreciation rate is 2.5% – which is the figure we want because the 
property was built after 1987– so no change is needed.  

 If you tick the box next to Link costs to property price, the Building costs 
automatically change if you change the Property price, always remaining the 
same percentage of the property price.  

 In our example, our couple simply estimates the value of the building. In 
practice, however, to satisfy ATO requirements at tax time, it is common to 
have a quantity surveyor certify the estimated original construction costs. 

 Depreciation of building is often referred to as a Capital or Building 
Allowance. 

 

Fig. 11: Depreciation of Building dialog  

Click on OK to return to the Data Entry Check List. The Depreciation of 

Building is now shown as $5,500. 
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Depreciation of Fittings 

Click on Depreciation of Fittings in the Check List to display the Depreciation 
of Fittings dialog. 

In 2017, the Australian Government decreed that depreciation of fittings 
would only be tax deductible for new items that the investor purchases. One 
of the reasons given for this change to tax law was that for the most part, the 
value of fittings in a second-hand property is already largely written off. 

As this property is an established one, we will leave the default value of 
fittings as zero. 

 

Fig. 12: Depreciation of Fittings dialog  

Click on OK to return to the Check List. Depreciation of Fittings is shown in 

the Check List as $0. 

 If the property had been a new one, our couple would have had a range of 
items to depreciate, the costs of which would normally have been available 
from the builder or a quantity surveyor. Earlier versions of PIA by default, 
assumed that the value of depreciable fittings was 6% of the property price. 
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Property Page 

Congratulations, you have now completed the entries for the investment 
property. The Property page of the Data Entry Check List now displays all of 
the new values and all of the items are ticked as shown below. If any of your 
values do not agree, go back to the item's dialog and check your entries 
against the example. 

 

Fig. 13: Data Entry Check List Property Page 

 It is now time to enter the data for 
financing the investment. To do this, 
click the Finance tab at the top of the 

Data Entry Check List.  

 While there are many variables 
shown on this page, they are divided 
into  three groups and are dealt with 
in three dialogs. The first of these 
encompasses variables that relate to 
the loan amount, the second to those 
that relate to the loan type and rate of 
interest, and the third to those that 
relate to costs in setting up the loan.  
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Loan Amount 

Click on Loan Amount in the Finance page of the Data Entry Check List. The 
Loan Amount dialog opens. Cash Invested has a default value of $50,000 as 
a deposit toward the property cost. However, as John and Anthea are 
borrowing all costs, set Cash Invested in the Property Cost row to $0 and 
press Enter. Click OK to return to the Data Entry Check List. The total Loan 
Amount and Amount Required are both shown as $503,762 while the Cash 
Invested is shown as zero. Note that all three variables have red ticks to the 

right, indicating that all three have been specified in the dialog. 

 

Fig. 14: Loan Amount dialog  

 Note that we have yet to specify the loan costs, which are shown as a default 
of $6,025. Once the actual costs are entered, the loan amount is adjusted 
automatically. 

 It is also possible to specify the individual loan costs from this dialog by 
clicking on the Loan costs button and to specify the loan interest and type 
by clicking on the Loan Type button. However, in this example, we will 
access these dialogs via the Check List buttons. 

 The Equity Invested variable would only be used where you already have 
equity in the property and simply wish to analyse the cash flows from this 
point in time, for example, when you are evaluating the impact of renovating 
or refurbishing an existing investment property. The Additional Loan variable 
would be used where you want to borrow additional funds to assist with the 
investment, for example, to provide a cash flow buffer in the first year. 
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Loan Interest and Type 

Next we have to specify the loan type and interest rate. Click on Loan Type 
or Interest Rate in the Check List to open the Loan Interest & Type dialog.  

First we have to change the loan type to Principal & Interest. Click on the 
radio button next to Principal & Interest at the top of the box. Then enter the 
value 4.8 into the Interest Rate (Average) field. The default value for the 
period of the loan is 25 years (shown under the Principal & Interest radio 
button). As we want a 30 year term, change the 25 to 30 as shown below.  

 

Fig. 15: Loan Interest & Type dialog 

 The loan type we have chosen in this example is a relatively simple one 
(principal & interest over 30 years). However, as the dialog indicates, it is 
possible to simulate a variety and even a combination of loan types. For 
example, it is possible to specify two separate loans, a combination of 
interest only and principal & interest, with varying terms. 

 The default loan type is Interest Only from 1 to 40 years. In fact the term is 
indefinite, but PIA calculates projections to a maximum of 40 years. 

Click OK to return to the Data Entry Check List. The Loan Type shows "P&I 

Yrs 1-30", the new Interest Rate is 4.80% and the annual Loan Repayments 
variable is $31,720  
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Loan Costs  

Click on Loan Costs in the Check List. The Loan Costs dialog opens. Loan 
costs are the costs associated with setting up a loan. Some of these costs 
may be a percentage of the loan amount, others are a flat fee.  

 If you enter a dollar amount in the Cost ($) column, the Flat fee tick appears. 
It disappears if you enter a percentage in the column % of Loan. Note the 
first three items tend to be percentages (no tick), the remainder tend to be 
flat fees (ticked).  

As a guide, loan costs generally fall somewhere between 0.5 and 2.5% of the 
total loan. In our example, the establishment fee is a fixed amount ($800), 
mortgage stamp duty no longer applies and because we have sufficient 
collateral, there is no mortgage insurance involved. Enter the other costs (flat 
rates) as shown in the figure below: 

 

Fig. 16: Loan Costs dialog 

Loan costs are written off over 5 years or over the term of the loan, 
whichever is shorter. We will leave the Loan cost write-off period unchanged 
and click OK to return to the Data Entry Check List. Loan Costs are now 
shown as $2,497 and, because these form part of the loan, the Loan Amount 

is now $500,279. 
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Finance Page  

You have now completed the entries for the Finance page and the Data 
Entry Check List should appear as shown in the Figure below, with all 
variables ticked. If there are any differences with the values on your page, 
check back to the corresponding dialog to see if you have missed any step.  

 

Fig. 17: Data Entry Check List Finance Page 

It is now time to enter the 
information that is specific to the 
investor. To do this, click the 
Investor tab at the top of the Data 

Entry Check List.  

  The Investor page, like the Finance 
page, is divided into groups (five in 
this case) of variables. These 
include details of personal income, 
home loan, living expenses, any 
existing investment portfolio, and 
last but not least, their taxable 
income. 
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Investor's Personal Details  

Click on Investor Details in the Data Entry Check List to display the Investor's 
Personal Details dialog. Investor Details you enter here can be used in later 
reports. These customized reports are useful if you are presenting an 
investment proposal to lenders – or simply want to have your figures 
checked by an accountant. The information below is for our example, but you 
can enter your own here if you do not wish to change it later. 

The Investor Type and the Work-Related Income & Deductions will be used 
to determine precise tax benefits from the investment. John earns $85,000 
per year, Anthea $45,000. Change the defaults, if necessary, as shown 
below. They have no other significant income or deductions so their total 
taxable work-related income is $130,000.  

Click OK to return to the Data Entry Check List and note that both Joint Work 

Income and Joint Work Deductions are also updated and ticked. 

 

Fig. 18: Investor Details dialog 

 You do not enter any income or deductions for existing investment 
properties in this dialog. As you will see, this is more easily entered in PIA's 
Current Investment Portfolio or Current Taxable Income dialogs. 
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Home Loan Details  

Click on Principal Residence or Amount Owing in the Data Entry Check List. 
The Home Loan Details dialog opens. This dialog allows you to specify the 
current market value of your home as well as describing the current status of 
your home loan. Your home's market value and remaining loan is used by 
PIA to assess your ability to borrow funds for investment. The amount you 
still owe, the interest rate you are currently being charged and the 
repayments you are currently making can also be used to determine the 
remaining term of the home loan. 

In our example, John and Anthea estimate that their own home has a market 
value of $580,000 and have an outstanding debt of $120,000 on it. They are 
paying interest on the loan of 6.0% and are making monthly repayments of 
$2,087. Make the changes to the default values as shown below and click 
OK to return to the Data Entry Check List. The three items Principal 

Residence (580,000), Amount Owing (120,000) and Home Loan 
Repayments (25,044 per year) are now ticked. 

 

Fig. 19: Home Loan Details dialog 

 It is also possible to specify projected changes to the home value and home 
loan interest rates over time by clicking the respective buttons.  

 Where the monthly loan payments are not know, it is possible to calculate 
them from a knowledge of the original loan, term and interest rate. PIA has a 
Loan Payment calculator and a Loan Consolidation dialog in which these 
can be calculated. Clicking the Loan Payments button (shown above) opens 
the Loan Consolidation dialog. 
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Living Expenses  

Click on Living Expenses in the Check List. The Annual Living Expenses 
dialog opens. This dialog allows you to specify your estimated annual living 
costs (excluding your home loan repayments) and how they might change 
over time. In order for PIA to help you estimate your capacity to invest, it 
needs to know how much money you need to set aside to live on. 

In our example, our couple have estimated that apart from their annual home 
loan repayments (25,044), their annual living expenses would amount to 
about $35,000. Change the default value in the first year to 35,000 and press 
the Enter key.  

 The figures for later years are indexed at a rate of 3% as defined in the 
Living Expense Projections area below. You could vary this assumption if 
necessary. As you will see later, you can specify how all key parameters 
change over time. 

Click OK to return to the Check List. The Living Expenses item is now 

$35,000 and is ticked.  

 

Fig 20: The Annual Living Expenses dialog 

 PIA has an alternative dialog (Annual Living Expense Budget) for estimating 
your current annual living expenses by working through a weekly, monthly 
and/or quarterly budget template. If you change the total expenses for the 
first year, this total amount is reapportioned pro rata over all the items in the 
budget template. This alternative dialog is accessible under the Investor 
menu. 
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Current Investment Portfolio 

Click on Portfolio Properties or Portfolio Value in the Check List. The Current 
Investment Portfolio dialog opens. As this is our couple's first investment 
property, there is no portfolio information to include in this example, So click 
Close to return to the Data Entry Check List and confirm that the Portfolio 

Properties and Portfolio Value are both zero. 

 

Fig 21: Current Investment Portfolio dialog 

 This dialog is used if you have existing investment properties and want to 
take account of their cash flows in relation to the property being analysed. 
You would need to have previously used PIA to enter the data for each 
property in turn, saving each to a file (as you will see later). You would then 
click the Create button and choose the PIA files that make up your existing 
investment portfolio. All the portfolio information would then be displayed in 
this dialog and be available for PIA to use in the current analysis (see "What 
about their next investment property?" later in this guide). 
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Taxable Income  

Click on Taxable Income in the Check List. The Tax Credits dialog opens. 
This dialog allows you to specify the method for calculating tax credits from 
negative gearing and whether the property is to be purchased in single or 
joint names. Your taxable income is calculated from your assessable income 
minus your allowable deductions. 

As Anthea & John currently have no income and deductions from any 
existing property portfolio, their taxable incomes will be the same as we 
entered earlier for their respective work-related taxable incomes. Make sure 
that the Use taxable income radio button is selected and uses the default 
Australian tax scale. 

 Using taxable income (if known) is more accurate than using marginal rate, 
as it does not assume all tax credits accrue at the same marginal rate of tax. 

In this example, the property is to be registered in joint names with a 50/50 
split. Click on the Joint names radio button – the Proportional Ownership 
changes to the default of 50% for the Investor and Partner. Click on OK to 

return to the Data Entry Check List. The item Taxable Income (Single) is 
renamed Taxable Income (Joint) and shows $130,000. 

 

Fig. 22: Tax Credits dialog  
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Investor Page 

With the Investor page now complete, you have just one more page of 
variables to enter before you start playing What If on the spreadsheet that 
you are creating. First, check to see that the variables on the Investor page 
agree with those shown below and that all are ticked. 

 

Fig. 23: Data Entry Check List Investor Page 

It is now time to click on the What If? tab at the top of the Data Entry Check 
List. This displays a page of variables used to determine annual projections.  

  These are divided into two 
groups: a group that historically 
has been closely aligned with 
the rate of inflation and another, 
the capital growth rate, which 
has consistently exceeded the 
rate of inflation. 
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Inflation Rate (CPI)  

Click on Inflation Rate (CPI) in the Data Entry Check List to open the Inflation 
Rate dialog. This dialog allows you to enter values for inflation to be used to 
index rental income, rental expenses, taxable income and living expenses. 
The convention used in this program is that a change in the overall consumer 
price index rate (CPI rate) results in a corresponding change in the inflation 
rate of all variables that are “linked” to it. Changing the inflation rate for a 
variable automatically removes the CPI link for that variable.  

Our couple select an average CPI rate of 2.5% based on official economic 
forecasts. However, they feel that with John confident of several work 
promotions over the next 10 years, a higher rate (say 3.5%) should apply to 
their taxable income. They also feel that their living expenses are likely to 
increase at the same rate, in line with their disposable income. 

First change the Average CPI Rate to 2.5% and press Enter. Note that the 
rates for all variables change to 2.5%. Now change the Average Rate for 
both Taxable income and Living expenses to 3.5% and press Enter. Neither 
of these variables is now linked to CPI. Click OK to return to the Check List.  

 
Fig. 24: Inflation Rate dialog  

 Choosing a rate of inflation is easy: You can simply use the current rate 
issued by the Australian Bureau of Statistics. However, choosing accurate 
rates of inflation to cover increases in rents, expenses, etc. over the life of 
your investment requires a crystal ball, something that does not come with 
the software. We suggest that you use the current published rate unless you 
have sound reasons to do otherwise.  
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Capital Growth Rate 

Click on Capital Growth Rate in the Check List. The Investment Property 
Growth dialog appears.  

Here you can enter the expected long-term growth rate for the value of the 
property. Overwriting the average annual rate sets that growth rate for all 
years, but each year can also be entered separately. Changes to any year 
are adopted for subsequent years. 

Change the value for the first year (1yr) to 4.5% and click OK to return to the 

Data Entry Check List. The Capital Growth Rate is now shown as 4.5%. 

 
Fig. 25: Investment Property Growth dialog 

 Choosing an accurate average future rate of capital growth is another case 
of crystal balling. It is the main reason these are referred to as “What If?” 
variables. We recommend the approach of choosing a reasonable starting 
value and once you have completed the analysis, choose values above and 
below the starting value to assess the impact on your investment decision. A 
general guide to choosing a reasonable starting value for capital growth 
might be to take the average inflation rate you have chosen and add 
between 2 to 3%. 

 In our example, our fictitious couple experienced a doubling in value of their 
own home over the previous ten years. This is equivalent to just over 7% 
average annual compound growth. Based on this – and the fact that the land 
is the major value component of this investment property and that land 
generally increases in value at a faster rate than the building – they are 
hoping for an average annual growth rate for this property over the next 10 
years of more than 5%. 

 In some markets, it makes more sense to use the capitalisation rate (net 
yield) as the factor determining property growth. We will stick with capital 
growth in this example.  
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What If? Page 

Congratulations! With the What If? page now complete, you have now 

finished the initial data entry and are ready to see the results of your work in 
a spreadsheet format. The next figure shows what the What If? page of your 
check list should look like if you have entered the correct values. 

 

Fig. 26: Data Entry Check List What If? Page 

 If you have different values, you can go back to the relevant dialog and 
check your entries against the example.  

Before we click Spreadsheet to go to the spreadsheet, tick the Use these 
values as the defaults check box. All the values you have entered will now 
become the default values for new files you open. 

Click Spreadsheet. This takes you to the Investment Analysis spreadsheet 

where you will see all of the results of your data entry. You can return to the 
Data Entry Check List at any time and continue to make changes if you wish 
or you can access the same data entry dialogs directly from the spreadsheet. 
To return to the Data Entry Check List from the spreadsheet, click the Check 

List icon (shown on the left) in the Tool bar or select Data Entry Check 
List from the View menu.  
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Play: Using the spreadsheet 
You made it! You have now arrived at the Investment Analysis spreadsheet 
– the place you will spend most of your time in PIA. Here you can see the 
data you entered and projections based on that data (or on default values, if 
not changed). Here you can make and "undo" changes to variables to 
explore "What if" scenarios and instantly see the impact on the "bottom line".  

 

 

Fig. 24: The spreadsheet showing the data entered in the example 

 The spreadsheet is really the main interface in PIA and provides direct 
access to all of the menus, dialogs and supporting analytical tools. The 
window can be resized and/or scrolled to view the entire contents of the 
spreadsheet. The coordinates of the spreadsheet window are saved on exit 
and reinstated when the program is restarted. 

Let's take a look at the elements of the Investment Analysis spreadsheet:  
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Menu bar  

 

At the top of the screen is the menu bar (File, Edit, Report, etc). The 
individual items within the menus may differ depending on the version of the 
software. The menus function in the normal way, providing access to all the 
powerful functions of the software. 

Tool bar 

 

Beneath the Menu bar is the Tool bar consisting of a series of icons, each of 
which provides quick access to commonly used functions. If you position the 
mouse pointer over an icon, a "tool tip" appears, telling you the meaning of 

the icon. For example, you can click the Check List icon (shown on 
left) if you wish to return to the Data Entry Check List. Or, you can 

simply display text under each of the icons. 

 

Item names  

The left-hand column of the spreadsheet contains the 
names of the items/rows in the spreadsheet. You will 
recognize many of these from the Check List. Other 
items, such as After-tax cash flow, show values 

calculated by PIA based on your entries or on default 
values. If you position the mouse pointer over an 
item, the pointer turns to the familiar "pointing hand", indicating that you can 
click to open the associated dialog. 

Input column  

The second column of the spreadsheet is referred to as 
the Input column. It contains a set of initial values 
associated with the row items. Most of these values can be 
selected with the mouse pointer and overwritten. Three 
colours are used on-screen in the spreadsheet cells. Blue values can be 

selected and overwritten directly. Double-clicking on them opens the 
corresponding dialog. Clicking once on black values opens a dialog 

immediately, as these values are calculated and cannot be directly 
overwritten. Calculated values are shown in red if the value is negative.  
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Projected values  

The five remaining columns show the 
projections for future years. The icons in the 
Tool bar (shown on right) allow you to scroll 
through the years. While PIA calculates projections up to 40 years, only 5 
years are shown at a time. By default, these are the years 1,2,3,5 and 10. 
You can display whichever years you wish. 

The "bottom line"  

 

The bottom three rows of the spreadsheet collectively represent your “bottom 
line”. The After-tax cash flow is the cash flowing into or out of your pocket 
each year. Negative values (in red) represent your investments in the 
property. The (Internal) Rate of return (IRR) is a measure of the return on 

these investments and is determined by the series of after-tax cash flows 
and the resultant equity built up in the property. It represents the interest 
equivalent of your investment (if it had been invested in a bank account) with 
the important difference that, because the equity remains invested, it is NOT 
taxed. The Pre-tax equivalent shows the equivalent pre-tax rate of return 
using the marginal tax rate. Your cost (income) per week shows you the 
projected weekly net cost or income resulting from the investment – the real 
"bottom line".  

Property Details  

 

The Property Details area below the spreadsheet provides a visual reminder 
of the property being analysed as well as additional parameter values that 
describe the investment. These parameters include the property and total 
cost (including purchase and loan costs), gross rent and gross yield, and net 
rent (net of rental expenses) and net yield. Two other useful parameters 
shown are an estimate of the initial cash investment required for the 
investment to break even in the first year (Cash neutral investment) and an 
estimate of the year by which the investment would break even (Cash 
positive by) for the specified initial investment. 

 If an image of the property has been loaded into PIA, it is displayed on the 
left-hand side of the Property Details area and is displayed in reports.  
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Time to save the file 

 From the File menu, choose Save. 

The Save As dialog opens. 

 It is recommended, but not critical, that 
you create a folder specifically to hold 
your PIA files. If this is independent of the 
folder containing the PIA program itself, it 
makes it easier and more efficient for 
backing up your own data.  

In this case you will create a folder called “My PIA Files” within the 
“Documents” folder. To create a new folder, first choose the Documents 

folder in the Save in: field. Next click the  symbol on the right-hand side, 
type in the name "My PIA Files" instead of the "New Folder" text, then click 
Open. The Save As dialog is displayed as shown below: 

 

Type in the name “Quick Start Example” in the File name field and click the 
Save button.  

 For simplicity, PIA uses individual files rather than a central database to 
store the information on all the individual investment properties. Each PIA file 
has a suffix ".PIA" and contains both the data you enter as well as the 
projections you make. However, to avoid entering all of your personal 
information repeatedly, you can choose to make any document the default 
template for any new files that you create. To do this, choose Save Default 
Template under the Settings menu or tick the "Use these values as the new 
defaults" check box at the bottom of the Data Entry Check List. 
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Answering the questions 

At the beginning of the example, John and Anthea had a list of questions that 
we wanted the software to help answer. Let's now take a look at the results: 

 

Fig. 25: The "bottom line" of the spreadsheet 

What return on investment can they anticipate?   
The Rate of return (IRR) field shows 19.76%. Again, recall that this is after-

tax (the return is not taxed as the equity remains invested). To achieve the 
same after-tax return on their investment from a bank deposit, it would have 
to earn 30.16%, as such interest would be taxed at their marginal rates.  

At this point it is worth playing “What If” to appreciate the power of the 
software. Select the 4.5% capital growth rate in the Input column and change 
it to 5.5%. The IRR should change 23.32%. Then change it to 3.5% and note 
that the IRR changes to 15.71%. Clearly, the growth rate is an important 
factor in determining the return on investment in this example.  

Change the growth rate back to the original 4.5% and note the effect on the 
After-tax cash flow – none! Capital growth affects the equity and the IRR, but 
does not affect the cash flows. 

 Rather than manually re-entering 4.5% in the capital growth field, you 
could have clicked on the Undo icon on the toolbar (shown on the 
right-hand side) to revert to the previous value. As you have made two 
changes (5.5%, then 3.5%), you would need to click Undo twice. 

What will the investment cost them after tax?   
Here, John and Anthea have to look at the After-tax cash flow projections 
and the Cost per week. When the loan is substantial, the after-tax cash flows 
are usually negative (negatively geared), but gradually become positive as 
rents rise with inflation and, in our example, when the loan is repaid. In our 
example the after-tax cash flow in the first year of the investment is -13,080 
or $252 per week. This will be their after-tax cost. 

 Note that a significant part of this cost ($7,651) in the first year is made up of 
principal loan payments (see Investments/principal row). If John and Anthea 
had chosen an interest-only loan, their after-tax cost would have been just 
$107per week. You can test this yourself by clicking on the Interest row title 
and changing the loan type to Interest only, but don’t forget to switch it back 
(or use Undo) to Principal & interest to follow the rest of this example. 
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How much tax will they save?   
From the Tax credit row, we can see that the total tax credits amount to 
$4,102. The term "tax credit" is another way of saying "tax saved as a result 

of the investment". In this case, the tax saved is assumed to be a reduction 
in the tax paid rather than a tax refund at the end of the year.  

 For PAYG taxpayers (formerly PAYE) to have their regular tax payments 
reduced because of negatively geared investments, they must complete the 
appropriate form as specified by the tax authorities. While the details may 
have changed from time to time, the principle remains the same (see 
www.ato.gov.au or www.ird.govt.nz for more information). 

To see where the tax credit comes from, we have to open the Tax Benefits 
item in the Investor menu. The following dialog appears:  

 

Fig. 26: The Tax Benefits dialog  

Under the 2021/22 tax scales, John and Anthea would collectively pay a total 
of $23,524 in tax on a taxable income of $130,000. With rental income of 
$19,924 and rental deductions of $35,455 (interest, expenses, depreciation 
and loan costs) their taxable income would drop to $114,469 and their tax 
payable would then be $19,422. The tax savings (individual and total) are 
shown at the bottom of the screen. Their total projected tax savings amount 
to $4,102. 

 You can investigate the impact on total tax savings by changing property 
ownership from joint to single (and back). 



Page 40 PIA Quick-Start Guide  

Can they afford it?   
We have already seen from the bottom line of the spreadsheet what the cost 
to John and Anthea will be. The $480,000 property, with the help of rent from 
the tenant and tax savings as a result of the investment, will cost them just 
$252 per week. But the question they must ask themselves is “Can they 
afford this amount”. To answer this, we will examine their total annual income 
(including the rental income from the property) and their total annual 
expenditure (taking account of their reduced tax liabilities). 

Open the Investment Capacity item in the Investor menu. John and Anthea's 
total income for the year, including rental income, is itemised in the left-hand 
column, while their total expenses, including the new rental expenses and 
investment loan interest is shown on the right. With a projected net surplus of 
$33,352, John and Anthea are satisfied that they can afford the investment. 

 

Fig. 27: The Investment Capacity dialog 

Can they afford more investment properties?   
With their confidence growing, they ask themselves how many properties like 
this they can afford. To answer this, it is simply a matter of increasing the 
number of properties in the Capacity section of the dialog until there is no 
longer a cash surplus. Change the 1 to 2 and press the Enter key. The 
surplus is reduced to a $20,462. So at this stage they may even be able to 
afford two properties. Change Investment properties back to 1 and click OK. 
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Print: Generating a report 

But will the bank lend them the money?   
The figures look good for John and Anthea and they decide to approach the 
bank for the money to finance their investment. Good figures professionally 
presented will make a great impression, so their next move is to print out a 
report of their analysis and take it first to their accountant (to cross-check 
their work) and then to their bank manager.  

The Report menu contains a number of options for displaying reports. Each 
report can be viewed and printed. Experiment with the reports in the Report 
menu. To return to the spreadsheet, choose Investment Analysis under the 
View menu. John and Anthea choose to print the five-page Investment 
Analysis report. 

 

Fig. 28: Excerpt from the Investment Analysis report (on screen)  

While the report will effectively present a business plan of their investment 
proposal to the bank manager, there is no guarantee that the loan will be 
forthcoming even though they have convinced themselves that they can 
afford it. Banks have their own criteria for assessing the risk in lending you 
money (loan-to-value ratios, debt-service ratios, etc), which are beyond the 
scope of this Quick-Start Guide. Powerful PIA tools that can help in this 
regard – including loan eligibility and borrowing capacity calculators as well 
as the Wealth Builder Spreadsheet – are described in the PIA User Guide. 
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What about their next investment property? 

Let’s assume that John and Anthea found a very smart banker who also 
used the PIA software and who showed them how, by clever use of credit 
lines and the refinancing of their existing $120,000 home loan debt, they 
would easily qualify for the investment loan and might even qualify for a 
second investment loan. They purchase the property and are so happy with 
their investment that they are immediately on the lookout for another 
property. Apart from all of the details on the new property, one of the 
personal items that will be different for the next property will be the taxable 
income used in assessing any tax credits. 

As we have already noted in Fig. 26, John’s new taxable income will have 
dropped from $85,000 to $77,235, while Anthea’s will have dropped from 
$45,000 to $37,235. These would then become the new taxable income 
figures showing in the Tax Credits dialog (Fig. 22) for the new analysis. 

One of the features of PIA that helps automate this process is the Current 
Investment Portfolio (dialog shown in Fig. 21), available in the Investor menu 
item and the Data Entry Check List. Clicking the dialog's Create button 

opens the Select Portfolio Files dialog (Fig. 29), which in turn makes it easy 
to select the files making up your current investment property portfolio. 

 

Fig. 29: Selecting files that make up the investment property portfolio  

When you choose the files that make up the existing portfolio (in this case 
just the one file that we have saved) and click Done, PIA extracts all of the 

property-related income and deductions, automatically updates the taxable 
income and makes it all available to the rest of the program. You can check 
this by opening the Tax Credits dialog (click on the Tax Credit row title in the 
spreadsheet). By the time you have several investment properties, you will 
probably find this feature essential (see the Help Topics item under the Help 
menu and look for Portfolio Analysis in the Special Topics). 
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Where to from here? 

The aim of the Quick-Start Guide was to help you install the software and run 
through your first investment analysis – to plug in the data, play with the 
parameters, and print out the results. But at this stage you have just 
scratched the surface of the software.  

They say that the best way to learn how to use the full potential of any 
program is to play with it. And when all else fails, consult the manual. Well 
help is close at hand. The Help topics item in the Help menu provides on-line 
access to information on all of the software’s features. 

 
Fig. 30: Help Topics  

In addition to the on-line Help Topics, this information is available in a 
comprehensive PIA Users Guide as a separate file. This is a PDF file, which 
can be read using Adobe Acrobat Reader, available as freeware at 
www.adobe.com/products/acrobat/readstep2.html.  

The PIA Users Guide is accessed via its icon in the PIA group (PIAPro or 
PIAFpu) under the All Program item in the Windows Start Menu. 

http://www.adobe.com/products/acrobat/readstep2.html
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Additional sources of information 

There are many sources of information that will help you understand the PIA 
software and the financial model on which it is based. Much of this informa-
tion is available in books and on the Internet. 

Building Wealth books 

The two books by Jan Somers currently in print are a valuable 
source of essential background information on the principles of 
property investment. 

 Building Wealth Story by Story (1998) 

 More Wealth from Residential Property (2001) 

Somerset website   www.somersoft.com.au  

This site has the latest news and information about our company, its 
products and its activities.  Check out the following: 

 The PIA Updates section for a list of all the latest changes 
to the PIA software.  

 The Support section for lists of FAQs on both PIA and 
investment property, copies of the latest User and Quick 
Start Guides, and opportunities for user feedback. 

Australian Taxation Office website   www.ato.gov.au 

This is the definitive source of tax advice in relation to property 
investment in Australia. There are many free publications available. 
In particular, we recommend the following: 

 Rental Properties 

 Guide to Capital Gains Tax  

 Guide to Depreciation 

Australian Taxpayers Association website   www.taxpayer.com.au 

The association is an excellent source of up-to-date tax advice and 
puts out a “plain English” tax guide each year.  

Real Estate Institute of Australia    www.reia.com.au 

A good source of up-to-date information on property-related issues. 

New Zealand Inland Revenue website   www.ird.govt.nz 

This is the definitive source of tax advice in relation to property 
investment in new Zealand. A free publication called Rental income 
(IR 264) explains tax rules for people who own rental property. 

 


